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About This Manual  v

ABOUT THIS MANUAL

The SCOPIA Desktop Server Administrator Guide provides information for 
Administrators about SCOPIA Desktop configuration and the web user 
interface. It includes detailed procedures for performing Administrator-related 
tasks.

RELATED 
DOCUMENTATION

The SCOPIA Desktop documentation set is available on the product CD-ROM. 
The manuals are in PDF format. 

Note You require Adobe Acrobat Reader version 5.0 or later to open the PDF 
files. You can download Acrobat Reader free of charge from www.adobe.com. 

FEEDBACK The team at RADVISION constantly endeavors to provide accurate and 
informative documentation. If you have comments or suggestions regarding 
improvements to future publications, we would value your feedback.
Please send your comments to doc_comments@radvision.com.
We thank you for your contribution.

http:\\www.adobe.com
mailto:doc_comments@radvision.com?subject=Query: SCOPIA Desktop v5.7
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1
INTRODUCING SCOPIA DESKTOP

SCOPIA Desktop is an application for establishing and participating in video 
conferences using desktops or laptops. SCOPIA Desktop consists of the 
SCOPIA Desktop Server and SCOPIA Desktop Clients, as shown in Figure 1-1.

Figure 1-1 Basic SCOPIA Desktop Deployment
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As a part of the SCOPIA Solution, SCOPIA Desktop enables video conference 
participants to communicate in a multiparty conference regardless of the device: 
a high end room conferencing system, a laptop from a branch or a teleworker’s 
personal computer. Table 1-1 describes SCOPIA Desktop specifications.

Table 1-1 SCOPIA Desktop Specifications

Specification Description

Client Connectivity 
Modes

� Live connection (audio, video, data, chat) for 
interactive participants

� Data-only connection with moderation 
capabilities, optional call back

� Streaming mode for non-interactive participants

Recording and Playback 
(Optional)

� Records audio, video, data and annotations
� Auto posted for easy web access
� PIN protected for access security
� Permit anyone to record or restrict users1 by 

administrator

1. When working with iVIEW Suite.

Data Collaboration � H.239 based data collaboration built into the client
� Room system-compatible data collaboration 

format (H.263+ XGA and H.264 up to 720p)
� Data shared from a room system visible in all 

other rooms and on desktops
� Data shared from a desktop visible on all other 

desktops and in rooms
� Share the entire screen or specific applications
� Text chat with emoticons for desktop users

Server Operating Systems Windows® 2003 and Windows® 2008

OS Language Supported 
for the SCOPIA Desktop 
Server

English

Outlook Add-in (optional) Supports Microsoft Outlook 2003 and 2007
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Table 1-2 describes SCOPIA Desktop features.

Table 1-2 SCOPIA Desktop Features

Feature Description

Meeting Types � Unmoderated meetings—Anyone can control 
the meeting

� Moderated meetings—Moderator PIN required 
to control the meeting

� Personal virtual rooms

Built-In NAT and 
Firewall Traversal

� Traverses local and remote firewall to ensure 
connectivity

� Automatically handles local and remote NAT 
private networks

� Automatic detection of optimal media path: 
UDP, TCP or tunneled TCP

Built-In Streaming � Built-in streaming server supports ‘watch-only’ 
participants

� Simultaneous streaming of audio, video and data
� Unicast or multicast streaming for scalability

Scheduling and 
Reservation

� Outlook plug-in for easy meeting scheduling
� Web-based meeting scheduling from any 

browser1

� Ports can be reserved assuring availability for 
critical meetings1

� Lotus Notes-based scheduling

Security � SRTP encryption to ensure the privacy of media 
and signaling between SCOPIA Desktop Clients

� Waiting room capability – Meeting will not start 
until moderator joins1

� Predefined virtual rooms – Optional mode 
where only predefined virtual rooms can be used 
for meetings1

� The Callback feature can be optionally disabled 
to avoid misuse
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Recording Meetings � Recording meetings
� Editing recorded meeting attributes
� Managing recordings (moderators only)
� Watching recorded meetings
� Auto-recording scheduled via iVIEW Suite

User Controls � Mute/unmute
� Enable/disable video camera
� Turn on/off local self view
� Choose your video layout (active speaker or 

continuous presence)
� Have the system call my voice or video number 

(callback)
� View consolidated conference roster (desktops 

and rooms)
� Request permission to speak when muted

Moderator Controls � Acquire moderator rights (may require 
moderator PIN)

� Lock meeting
� Terminate meeting
� Invite any room system or phone (dial-out)
� Global directory for easy inviting
� Start/stop streaming
� Start/stop recording
� Mute, unmute and disconnect any participant
� DTMF keypad
� Grant permission to speak
� Block a participant’s video

Table 1-2 SCOPIA Desktop Features (continued)

Feature Description
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Table 1-3 describes rates and codecs SCOPIA Desktop sends and receives 
depending on which video quality is set.

Layout Selection � Automatic
� Mixed
� Side-by-side video and presentation
� Stacked
� Full screen video or presentation

Client Interface 
Languages

� Chinese (Simplified)
� Chinese (Traditional)
� English (US)
� French
� German
� Italian
� Japanese
� Korean
� Portuguese
� Russian
� Spanish (international)

1. When working in conjunction with iVIEW Suite

Table 1-2 SCOPIA Desktop Features (continued)

Feature Description

Table 1-3 Rates and Codecs Supported by SCOPIA Desktop

Type Call Rate Audio Video (No Data) Video with Sending Data Data

Standard 
Definition

384K G.722.1 at 24K H.264 CIF at 360K H.264 CIF at 168K H.263+XGA or 
H.264 720p at 192K

High 
Definition

1M G.722.1 at 24K Send H.264 480p at 500K
Receive H.264 720p at 1M

Send H.264 480P @ 256K 
Receive H.264 720P @ 768 K

H.263+ XGA or 
H.264 720P at 256K
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Table 1-4 describes recommended client computer requirements.

Table 1-4 Recommended Client Computer Requirements

Specification Description

For interactive conferencing For Standard Definition:
Pentium 4 3.0GHz or faster or 
Centrino Mobile Processor 1.8 
GHz of faster
1GB RAM

For High Definition:
Dual Core 2.0 GHz or faster
2GB RAM

Operating System (OS):
Windows® XP Service Pack 2 or 
higher
Windows® Vista™ SP1

Helper Application: Web Browser:
Internet Explorer® 6, 7 or 8

For watching webcast or a recorded 
meeting

Operating System:
Windows® 2003
Windows® 2008
Windows® XP
Mac® OS X1

Web Browsers:
Internet Explorer® 6, 7 or 8
Firefox® 2 or 3
Safari™ 3.12 

1. You can install and use SCOPIA Desktop Conference Client on computers using the Microsoft 
Windows and Mac. For the Mac OS, SCOPIA Desktop supports limited functionality allowing users 
to watch webcasts and recordings but not to participate in live meetings.
2. Used for streaming on Mac OS X operating systems.
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In a SCOPIA Desktop client, a CPU auto-detect mechanism is used to define 
whether this client is capable of performing interactive conferencing using a 
high definition or standard definition, and at what rate the client can send and 
receive video.
The CPU estimation is based on the number of physical cores available on the 
client computer and is performed using this formula:

SCOPIA Desktop uses the EstimatedCPU value to define what framerate to 
allow for each resolution. shows framerates that SCOPIA Desktop sends to 
clients.

Table 1-5 Framerates sent by SCOPIA Desktop

CPU CQCIF QCIF CIF 480p HD

6Ghz 30 30 30 30 30

4Ghz 30 30 30 15 15

3Ghz 30 30 30 5

2Ghz 30 30 15 5

<2Ghz 30 30 15 1

EstimatedCPU NumberPhysicalCore SpeedOfEachCore×=
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2
CONFIGURING SCOPIA DESKTOP FOR 
ADMINISTRATORS

� Accessing the Administration Interface on page 10
� Viewing Server Status and Port Resource Usage on page 10
� How to Configure SCOPIA Desktop Server Settings on page 11
� Configuring Gatekeeper IP Address on page 13
� Configuring Client-Related Settings on page 14
� How to Configure Meeting Control Settings on page 17
� Defining Security Settings on page 20
� Configuring Meeting Features on page 21
� Configuring Meeting Access Instructions on page 23
� Configuring Global Contact Directory on page 24
� How to Configure Streaming Server Settings on page 25
� How to Configure Recording Server Settings on page 29
� Updating the SCOPIA Desktop Server IP Address on the Streaming 

or Recording Servers on page 36
� How to Manage Recordings on page 37
� How to Restore Recordings on page 43
� How to Brand SCOPIA Desktop User Interface on page 45
� Viewing the SCOPIA Desktop Online Help on page 49
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Accessing the Administration Interface

ACCESSING THE 
ADMINISTRATION 
INTERFACE

 ) Procedure

1 Open the Internet browser.
2 Enter the following URL:

http://<host>[:<port>]/scopia/admin
where <host> is the location of your corporate SCOPIA 
Desktop Server.

3 On the Administration page, enter your user name and password.
4 Click Sign In.

The default user name and password are both “admin”.

VIEWING SERVER 
STATUS AND PORT 
RESOURCE USAGE

The SCOPIA Desktop Status tab displays status information about the SCOPIA 
Desktop Server and other servers with which it interacts:

� Gatekeeper—A RADVISION ECS Server.
� Streaming—The Darwin Streaming Server. This information appears 

only if the SCOPIA Desktop Server is configured to manage 
streaming.

� SCOPIA MCU or iVIEW Suite—An optional server used to 
moderate the SCOPIA Desktop meetings. If no server is 
configured to moderate SCOPIA Desktop meetings, no link 
appears on this tab.
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How to Configure SCOPIA Desktop Server Settings

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Status in the sidebar.
2 Click the SCOPIA Desktop Server tab.
3 Click the link showing the IP address of a server to display the 

settings for that server.
The indicator next to each link shows whether or not the 
connection to the target server or registration with the 
Gatekeeper is successful. When the indicator is red, a tooltip 
containing error details is available. Click the red indicator to 
view further error information. 

Related Topics

� How to Configure Streaming Server Settings on page 25
� How to Configure Meeting Control Settings on page 17

HOW TO 
CONFIGURE 
SCOPIA DESKTOP 
SERVER SETTINGS

� Configuring Settings for Single/Multiple-NIC Deployments on 
page 11

� Configuring SCOPIA Desktop Server Network Interface on page 12
� Changing IP Address of the SCOPIA Desktop Server on page 13

CONFIGURING 
SETTINGS FOR 
SINGLE/MULTIPLE-NIC 
DEPLOYMENTS

The SCOPIA Desktop Server can have multiple Network Interface 
Cards (NICs). Depending on the deployment and network configuration, you 
might want to control which NIC is used for various server communications.
For example, in secure multiple NIC deployments you can use a NIC configured 
behind the firewall to communicate with various servers, while using another 
NIC for SCOPIA Desktop Clients to connect to. In this case you must configure 
the SCOPIA Desktop network interface address to represent the NIC behind the 
firewall, and then in the Public Address field enter a DNS name which resolves 
to the NIC outside the firewall and is accessible both inside and outside the 
corporate network.
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How to Configure SCOPIA Desktop Server Settings

For single NIC deployments, the network interface address represents the 
SCOPIA Desktop Server IP address that clients use to connect to SCOPIA 
Desktop. In single NIC deployments with both internal and external clients, this 
value represents an external, statically-mapped SCOPIA Desktop Server IP 
address.
SCOPIA Desktop Clients can connect to the SCOPIA Desktop Server either by 
an IP or a DNS name. If a DNS name is not specified in the Public Address 
field, the SCOPIA Desktop network interface address is used. However, in 
many deployments the SCOPIA Desktop Server network interface address is not 
accessible to clients outside the intranet, due to NAT or firewall restrictions. 
Therefore, we recommend that you specify the Public Address, which must be a 
DNS name resolving to the correct SCOPIA Desktop Server IP address both 
inside and outside the corporate network.

CONFIGURING 
SCOPIA DESKTOP 
SERVER NETWORK 
INTERFACE

The SCOPIA Desktop Server communicates with the following types of servers 
in the deployment:

� SCOPIA MCU and ECS—For media and call setup.
� iVIEW Suite or SCOPIA MCU—For moderation and meeting 

control.
� Darwin Streaming Server—For media and control.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Settings in the sidebar.
2 Click the Server tab.
3 From the SCOPIA Desktop Network Interface list, choose the IP 

address that the SCOPIA Desktop Server must use for SCOPIA MCU 
and ECS communications.
The indicator next to the Address field shows whether 
connection to the SCOPIA Desktop Server is successful or not. 
When the indicator is red, a tooltip containing error details is 
displayed. 

4 For secure multiple NIC deployments, enter a DNS name in the Public 
Address field.
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Configuring Gatekeeper IP Address

5 Click the Client tab.
6 Click OK or Apply.

CHANGING IP 
ADDRESS OF THE 
SCOPIA DESKTOP 
SERVER

If the IP address of the server on which the SCOPIA Desktop Server is installed 
changes, you need to update SCOPIA Desktop Server components with its new 
IP address.

 ) Procedure

1 Click Start > Settings > Control Panel.
2 Double-click Add or Remove Programs.
3 From the list of programs, choose SCOPIA Desktop, and then 

Change.
The Setup Wizard opens.

4 In the Welcome screen click Next.
5 In the Program Maintenance screen, choose Modify, and click Next.
6 In the Custom Setup screen, click Next.
7 In the SCOPIA Desktop Serial Key screen, click Next.
8 In the SCOPIA Desktop Network Configuration screen, click Next.
9 In the SCOPIA Desktop Hostname Configuration screen, click Next.
10 In the SCOPIA Desktop Recording Configuration screen, click Next.
11 Click Install.

CONFIGURING 
GATEKEEPER IP 
ADDRESS

SCOPIA Desktop is designed to work with either a single SCOPIA MCU, or 
with iVIEW Suite which manages multiple MCUs. If iVIEW Suite is configured 
to moderate SCOPIA Desktop meetings, use the IP address of a gatekeeper 
managed by iVIEW Suite. If iVIEW Suite manages more than one gatekeeper, 
use the IP address of a gatekeeper assigned to the same iVIEW Suite zone as 
SCOPIA Desktop.
If a single SCOPIA MCU is configured to moderate SCOPIA Desktop 
meetings, use the IP address of the same gatekeeper to which the MCU is 
registered. If no server is configured to moderate SCOPIA Desktop meetings, 
use the IP address of a gatekeeper configured for the SCOPIA Desktop 
deployment.
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Configuring Client-Related Settings

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Settings in the sidebar.
2 Click the Server tab.
3 Enter the required address in the Gatekeeper IP Address field. 

The indicator next to the Address field shows whether 
registration to the Gatekeeper is successful. When the indicator 
is red, a tooltip containing error details is displayed. 

4 Click OK or Apply.

Related Topics

� Configuring Meeting Access Instructions on page 23

CONFIGURING 
CLIENT-RELATED 
SETTINGS

During this procedure you choose the video quality:
� Standard Definition

This option limits SCOPIA Desktop Clients to a connection of 
standard definition at the maximum call rate you specify. If you 
define a service on the SCOPIA MCU that enables H.323 
endpoints to use a higher bandwidth rate or high definition 
without enabling high definition on SCOPIA Desktop, 
SCOPIA Desktop calls using this service are transcoded down 
to the lower rate at standard definition (CIF resolution) for the 
SCOPIA Desktop Client. If you select a SCOPIA MCU service 
with a bandwidth rate lower than the value set in the Maximum 
Call Rate list, then the latter is used for the standard definition 
call to the SCOPIA Desktop Client.

� High Definition

This option allows SCOPIA Desktop Clients to connect to a 
conference in high definition mode. If you select this option, 
you must select a maximum call rate of at least 1 MB and a 
minimum video rate of 768 Kbps to enable the conference to 
continue in 720p high definition video resolution for all clients. 
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Configuring Client-Related Settings

The SCOPIA Desktop Client sends up to 512 Kbps of 480p 
video resolution and receives the maximum call rate or rate of 
the service selected (the lower value of the two) of 720p video 
resolution. If you select a lower maximum call rate you can 
force the high definition service to send 480p to all clients at the 
lower bandwidth. If you select a lower minimum video rate you 
can enable a 720p service to decrease to 480p if bandwidth 
limitations during the conference require it.
When in high definition mode and connected to a high 
definition service, SCOPIA Desktop limits fast update requests 
to avoid degradation of the video quality or frame rate to all the 
connected endpoints.
If a SCOPIA Desktop connects to a standard definition service 
or if there are no high definition ports let for the high definition 
service, then the standard definition quality is used during a 
SCOPIA Desktop conference.

You can also configure the maximum transmission unit (MTU) size the 
SCOPIA Desktop Client uses for communicating with SCOPIA Desktop. The 
default value is 1360. This setting should match the setting on the 
SCOPIA MCU used and your network setting to avoid fragmentation.
If you need to limit UDP ports that are opened on the firewall to allow 
conference clients to send RTP to SCOPIA Desktop, you must define a 
multimedia port range. We recommend that you use a limited range between 
2326 and 65535. If this option is used, each client connection uses three ports; 
therefore to define the range, multiply the number of connections allowed by 
your license by three.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Settings in the sidebar.
2 Click the Client tab.
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Configuring Client-Related Settings

3 To configure settings for standard definition:
a In the Maximum Video Quality area, verify that the 

Standard Definition option is selected.
b From the Maximum Call Rate list, choose a bandwidth 

rate.

Note The default call rate value defined for the SCOPIA Desktop service 
configured on the SCOPIA MCU is 384 Kbps.

4 To configure settings for high definition:
a In the Maximum Video Quality area, choose High 

Definition.
The Minimum Video Bandwidth list is automatically 
updated to display 512 Kbps as the lowest available value.

b From the Minimum Video Bandwidth list, choose a 
bandwidth rate.

Note SCOPIA Desktop does not flow control calls below the minimum 
video bandwidth rate. If this value is set to 512, SCOPIA Desktop negotiates 
a call down to 512 Kbps, which changes the video sent by SCOPIA MCU 
from 720 p to 480 p.

c From the Maximum Call Rate list, choose a bandwidth 
rate.

5 In the Maximum MTU Size field, enter a value.
6 If necessary, configure a multimedia port range by entering the lowest 

multimedia port and the highest multimedia port values.
7 Click OK or Apply.
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How to Configure Meeting Control Settings

HOW TO 
CONFIGURE 
MEETING CONTROL 
SETTINGS

� Configuring Server Type on page 17
� Configuring SCOPIA MCU Server Settings on page 17
� Configuring iVIEW Suite Server Settings on page 18

CONFIGURING SERVER 
TYPE 

Configure the type of server according to these recommendations:
� For a simple deployment including a single SCOPIA MCU, 

configure the MCU.
� For deployments containing SCOPIA Desktop with multiple 

SCOPIA MCUs but without iVIEW Suite, you can connect to 
multiple MCUs but you do not have moderation control. Without 
iVIEW Suite, the SCOPIA MCUs do not cascade MCUs into virtual 
meetings. 

� For more complex deployments, select the iVIEW Suite.

Note When you configure SCOPIA Desktop to work with iVIEW Suite, 
participants can access their own virtual room settings via the Virtual Room button 
in the Preferences screen on the SCOPIA Desktop entry page.

Related Topics

� Configuring Settings for Single/Multiple-NIC Deployments on 
page 11.

� Configuring SCOPIA MCU Server Settings on page 17
� Configuring iVIEW Suite Server Settings on page 18

CONFIGURING 
SCOPIA MCU 
SERVER SETTINGS

This section describes how to configure a SCOPIA MCU to moderate your 
SCOPIA Desktop meetings.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Meeting Control in the sidebar.
2 From the server type list, choose SCOPIA MCU.
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How to Configure Meeting Control Settings

3 Enter the MCU IP address.
The indicator next to the Address field shows whether or not the 
connection to the target server is successful. 

4 Enter a user name and password for accessing the MCU Administration 
web user interface.

5 Re-enter the password in the Confirm field. 
The default user name is “admin”. By default, there is no 
password.

6 From the SCOPIA Desktop Network Interface list, choose the IP 
address that the SCOPIA Desktop Server.
The SCOPIA Desktop Server uses this IP address for MCU 
Server communications.

7 If necessary, click Enable Raise Hand feature in SCOPIA Desktop 
meetings.
For deployments with multiple SCOPIA Desktop Servers, we 
recommend that you clear this check box. A moderator using 
one SCOPIA Desktop Server cannot see a request made by a 
participant using another SCOPIA Desktop Server.

8 Click OK or Apply.

Related Topics

� SCOPIA Solution Deployment Guide

CONFIGURING 
IVIEW SUITE SERVER 
SETTINGS

The source H.323 ID is used only for advanced routing with iVIEW Suite. 
iVIEW Suite contains a corresponding field and uses the source H.323 ID to 
identify clients from a particular SCOPIA Desktop Server, and then route clients 
to the appropriate SCOPIA MCU.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

� To allow the SCOPIA Desktop clients to connect to the 
SCOPIA Desktop server via port 80, go to Control Panel > 
Administrative Tools > Services on the iVIEW Suite server and 
disable the IIS Administration service, HTTP SSL service, and World 
Wide Web Publishing services. This can be done either before 
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How to Configure Meeting Control Settings

installing the SCOPIA Desktop Server software or when receiving 
the "ip address/ port is in use" error during the installation. After 
disabling these services, the installer will complete normally and the 
desktop clients will be able to connect to the desktop server using port 
80.

 ) Procedure

1 Click Meeting Control.
2 From the server type list, choose iVIEW Suite.
3 Enter the address of the iVIEW Suite server. 

When using Single Sign-On (SSO) with the iVIEW Suite, we 
recommend that you enter the local server name rather than the 
DNS name or IP address. For example, if the DNS name is 
<server1.company.com>, configure this setting to <server1>.

4 Enter the HTTP port of the iVIEW Suite server.
The default HTTP port is 8080.

5 Enter the source H.323 ID of the SCOPIA Desktop.
6 From the SCOPIA Desktop Network Interface list, choose the IP 

address. The SCOPIA Desktop Server uses this IP address for 
iVIEW Suite Server communications.

7 If necessary, click Enable Raise Hand feature in SCOPIA Desktop 
meetings.
For deployments with multiple SCOPIA Desktop Servers, we 
recommend that you clear this check box. A moderator using 
one SCOPIA Desktop Server cannot see a request made by a 
participant using another SCOPIA Desktop Server. For more 
information, see the SCOPIA Solution Deployment Guide.

8 Click OK or Apply.
The indicator next to the Address field shows whether or not the 
connection to the target server is successful. 
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Defining Security Settings

DEFINING 
SECURITY 
SETTINGS

This section describes how to define access control to the SCOPIA Desktop 
Administration web user interface and to enable sRTP media encryption 
between SCOPIA Desktop Clients and the SCOPIA Desktop Server.
Encrypting media (audio, video, presentation) between SCOPIA Desktop Server 
and the SCOPIA Desktop Client might be used, for example, in a corporate 
deployment where the SCOPIA Desktop Server is used to bring in people from 
outside your network. Since this option only enables secure encryption of the 
media, you need also to secure the web portal. Choosing the Allow Users to 
have SCOPIA Desktop call them back option enables the video device 
callback option on the SCOPIA Desktop user entry page. When users select Use 
my computer for presentation only on connecting to a meeting, the Callback 
my video device number option becomes available. The Callback my video 
device number provides the option to call back the H.323 device when the 
users connect, so that users can connect in the “data only” mode to a meeting 
from their computers and automatically connect their H.323 devices at the same 
time. 

Note In the “data only” mode, users can see the participant list, moderate, chat, 
and show or view presentations. Users can view or send neither audio nor video.

The H.323 device can be disconnected automatically when users disconnect 
their computers from the call.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Settings in the sidebar.
2 Click the Security tab.
3 Locate the Access Control area.
4 Enter the administrator login information in the relevant fields.
5 Locate the Security area.
6 If necessary, click Encrypt Media (between Desktop and Server).
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Configuring Meeting Features

7 If necessary, click Allow Users to have SCOPIA Desktop call them 
back.
This option is available only after you define a meeting control 
server for SCOPIA Desktop.

8 Click OK or Apply.

Related Topics

� SCOPIA Solution Deployment Guide

CONFIGURING 
MEETING 
FEATURES

This section describes how to configure meeting features including the Desktop 
Sharing and Chat options and Push to Talk option as well as displaying an 
additional panel.
When the Desktop Sharing option is enabled, the SCOPIA Desktop participants 
can present applications and share their desktops with other participants. You 
can optionally allow only moderators to share their desktops. When desktop 
sharing is not enabled, the video display layout in the SCOPIA Desktop Client 
changes to display the local video in a small frame and the remote video in a 
large frame. The Present and PIP buttons are unavailable and participants cannot 
change this layout.
Configure the Push to Talk option to define how participants use the microphone 
button in the SCOPIA Desktop Live Meeting Console:

� Allow users to join a meeting with their microphone on—The 
microphone is on and the audio output is sent when participants 
enter a meeting. The participants must click the microphone 
button to mute themselves.

� Force users to join a meeting with their microphone off—The 
microphone is off and the audio output is not sent when participants 
enter a meeting. The participants must click the microphone button to 
unmute themselves.

� Force users to hold down their microphone button while 
speaking—Participants must click and hold down the 
microphone button to activate their microphones and to send 
their audio output.

You can enable the custom panel option to display an additional custom panel in 
the SCOPIA Desktop Live Meeting Console. The custom panel docking 
location is preconfigured and cannot be changed; meeting participants can move 
the panel after undocking it.
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The URL parameters are passed to the custom URL as follows:
?meetingid=NNN&nickname=XXX, where NNN is the ID of the meeting that 
the user is connected to, and XXX is the nickname of the connected user.
You can also use the custom panel URL to specify additional URL parameters. 
You must use the URL-encoding for the additional URL parameters. For 
example, if the custom panel URL is 
"http://www.mycustompanel.com/myservlet?arg1" and the SCOPIA Desktop 
entry page or conference room is launched with the additional argument 
"?CUSTOM=arg2%26arg3% 3D123", the custom panel opens to the URL 
"http://www.mycustompanel.com/myservlet? arg1&arg2&arg3=123".

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Settings in the sidebar.
2 Click the Meeting Features tab.
3 Define the Enable Desktop Sharing and Enable Chat options as desired.

For deployments with multiple SCOPIA Desktop Servers, we 
recommend that you do not enable the chat option. A participant 
using one SCOPIA Desktop Server cannot join the chat started 
by a participant using another SCOPIA Desktop Server.

4 Define the additional custom panel option as desired:
a Click the Display an additional panel in the 

conference room check box to enable the option.
b Enter the URL in the field.

5 Define the Push to Talk option as desired.
6 Click OK or Apply.

Related Topics

�  SCOPIA Solution Deployment Guide
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CONFIGURING 
MEETING ACCESS 
INSTRUCTIONS

This section describes how to view the default instructions for joining a meeting 
that the SCOPIA Desktop Server Outlook add-on sends to invitees, and how to 
modify the contents of these e-mail invitations.
While modifying the contents of e-mail invitations, you can define the link for 
connecting to a SCOPIA Desktop meeting. If you have multiple 
SCOPIA Desktop Servers and want participants to know about them, insert link 
information for each of them into each SCOPIA Desktop e-mail configuration. 
For example, if you have one SCOPIA Desktop in Europe, one in Asia, and 
another in the US, you could place the following information in your e-mail:
“From Europe, connect to http://europe.server.com/scopia?ID=1234
From Asia, connect to http://asia.server.com/scopia?ID=1234
From the US, connect to http://us.server.com/scopia?ID=1234.”

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Settings in the sidebar.
2 Click the Invitations tab.

The default instructions for accessing the meeting from a 
desktop, phone or video conferencing device appear in the 
screen.

3 In the Desktop Access section:
� Click Meeting URL to insert a link to the meeting.
� Click Client Installation to insert a link used to ensure 

that the SCOPIA Desktop Client is installed and 
up-to-date. 

Note The automatically inserted server address is the SCOPIA Desktop 
Fully Qualified Domain Name specified during installation.

4 In the Phone Access area, click E.164 to insert the required E.164 alias.
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5 In the Video-Conference Device Access area, click E.164 to insert the 
required E.164 alias.

6 Click OK or Apply.

CONFIGURING 
GLOBAL CONTACT 
DIRECTORY

The global contact directory is a list of contacts you define and which 
SCOPIA Desktop moderators use to invite participants to a SCOPIA Desktop 
meeting. The address you configure in the global contact directory can be in one 
of these formats:

� IP address
� E.164 number
� telephone number with the proper dial plan prefix
� SIP address

You can perform configuration described in this section only after meeting 
control settings are configured.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Directory on the sidebar.
2 To add a contact to the global directory:

a Click Add.
b Enter the contact display name and the address.
c Click OK.

3 To delete a contact from the global directory:
a Click the check box next to the contact.
b Click Delete.
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HOW TO 
CONFIGURE 
STREAMING 
SERVER SETTINGS

This section describes how to configure Darwin Streaming Server settings. 
Streaming can be managed either by a single SCOPIA Desktop Server or by 
multiple SCOPIA Desktop Servers. If a single SCOPIA Desktop Server is set to 
manage streaming, all other participants are directed to this server. If multiple 
SCOPIA Desktop Servers are configured to manage streaming, they manage 
streaming independently.
To designate a single SCOPIA Desktop Server to manage streaming, enable 
streaming on this SCOPIA Desktop Server. In this case you must disable 
streaming on other SCOPIA Desktop Servers in the same deployment. 
However, you can configure those servers to allow watching of webcasts from 
the SCOPIA Desktop Server on which streaming is enabled.
To enable multiple SCOPIA Desktop Servers for managing streaming, enable 
streaming on each SCOPIA Desktop Server in this deployment.

Note When multiple SCOPIA Desktop Servers manage streaming, streaming 
must be enabled or disabled on each individual SCOPIA Desktop Server. For 
example, if streaming is enabled for a meeting or virtual room, a moderator cannot 
disable it, because each SCOPIA Desktop Server manages streaming 
independently. If a moderator connected to one SCOPIA Desktop Server disables 
streaming, the other SCOPIA Desktop Server still continues to stream, unless it is 
disabled by its moderator as well.
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Table 2-1 compares using a single SCOPIA Desktop Server to using multiple 
SCOPIA Desktop Servers for streaming.

� Configuring This SCOPIA Desktop Server to Manage 
Streaming on page 26

� Configuring an Alternate SCOPIA Desktop Server for Watching 
Webcasts on page 29

CONFIGURING THIS 
SCOPIA DESKTOP 
SERVER TO MANAGE 
STREAMING

This section describes how to enable this SCOPIA Desktop Server to manage 
streaming and to configure settings for this server.
The public address you define during this procedure performs a similar role to 
the public address defined for the SCOPIA Desktop Server. If the Streaming 
Server resides behind a NAT, the clients might not resolve the Streaming Server 
IP address. In this case the clients use the public address to connect to the 
Streaming Server.

Table 2-1 Comparison of Deployment Characteristics

Characteristic Single SCOPIA Desktop 
Server enabled for 
streaming

Multiple SCOPIA Desktop 
Servers enabled for 
streaming 

HTTP 
performance

Slower HTTP performance over 
the Internet between dispersed 
sites and the designated 
SCOPIA Desktop Server. 

Faster HTTP performance 
within local sites.

Load on 
Streaming Server

Many streaming clients at 
different sites sharing the 
resources of a single streaming 
server.

Streaming clients at individual 
sites share a local streaming 
server. 

SCOPIA Desktop 
Server 
management

Single location for managing 
streaming.

Streaming must be enabled or 
disabled on each individual 
SCOPIA Desktop Server.

Participant count All participants connected to the 
central SCOPIA Desktop Server 
are shown in the meeting display 
with the exception of multicast 
clients. 

Only participants connected to a 
specific local SCOPIA Desktop 
Server are shown.
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You can enable and configure multicast streaming to allow unlimited number of 
simultaneous streaming connections. Multicast streaming in SCOPIA Desktop 
is performed without Darwin Streaming Server support. If the IP address of a 
client computer is not within the multicast IP address range you configure, this 
client will use a unicast streaming connection. During multicast configuration 
you also need to define the Time to Live value—the number of transmissions of 
a multicast packet that SCOPIA Desktop performs. Setting this value to 1 means 
that a multicast packet stays within a local network. The change in the multicast 
streaming configuration applies only to meetings created after the change takes 
place; the change does not effect meetings in progress.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Streaming in the sidebar.
2 Click the Connection tab.
3 Choose Enable Streaming from the list.
4 Enter the IP address of the Darwin Streaming Server.
5 From the SCOPIA Desktop Network Interface list, choose the IP 

address. 
The SCOPIA Desktop Server uses this IP address for Darwin 
Streaming Server communications.

6 In the TCP Port field, enter a TCP streaming port. 
The default port is 7070.

Note If you use a TCP port different from the default value of 7070, you 
must open this port on the firewall.
For more information about configuring a UDP connection, refer to the 
“Configuring Streaming or Playback using the UDP connection” section of 
the SCOPIA Solution Deployment Guide.

7 In the Public Address field, enter a FQDN.
We recommend that you use a FQDN that clients can resolve. 

8 Click OK or Apply.
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9 Click the Settings tab.
10 Define the size of the video used for streaming by choosing one of the 

options: Small (QCIF) or Medium (CIF).
11 From the Rate list, choose a value to define the bit rate for the streaming 

feed between SCOPIA MCU and the SCOPIA Desktop Server.
12 If necessary, configure multicast settings:

a Check the Enable Multicast option.
b Enter the multicast IP address.

The valid multicast IP address is in the range of 224.0.0.1 
and 239.255.255.255. 

c Enter the Time to Live value.
d Define clients that will be able to watch multicasts by 

entering IP range in the fields and clicking  .

13 Click OK or Apply.
The indicator next to the Address field shows whether not 
registration to the Darwin Streaming Server is successful. When 
the indicator is red, a tooltip containing error details is 
displayed. 

Related Topics

� Configuring Settings for Single/Multiple-NIC Deployments on 
page 11

� How to Configure SCOPIA Desktop Server Settings on page 11
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CONFIGURING AN 
ALTERNATE 
SCOPIA DESKTOP 
SERVER FOR 
WATCHING WEBCASTS

This section describes how to configure the SCOPIA Desktop Server to refer to 
an alternate SCOPIA Desktop Server which is used for streaming in order to 
watch webcasts.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Streaming in the sidebar.
2 Click the Connection tab.
3 Choose Disable Streaming from the list.
4 Check the Allow watching of webcasts from an alternate 

SCOPIA Desktop server option.
5 In the Server URL field, enter the URL of the alternate 

SCOPIA Desktop Server.
6 Click OK or Apply.

HOW TO 
CONFIGURE 
RECORDING 
SERVER SETTINGS

SCOPIA Desktop allows users to record meetings and to view recorded 
meetings. A recording includes all media types: the audio, video and 
presentation. Servers used for recording meetings must have a recording license 
installed on them. SCOPIA Desktop supports up to 10 simultaneous recordings.

� Viewing Recording Server Status on page 29
� About Configuring the SCOPIA Desktop Recording Server 

Connection on page 31
� Configuring Recording Parameters on page 33
� Modifying the Disk Space and Storage Location for Recordings on 

page 35

VIEWING RECORDING 
SERVER STATUS

The Recording Status tab displays this information:
� Recording Server—Displays the address of the 

SCOPIA Desktop Recording Server.
� Recorder—Displays the connection status between the 

SCOPIA Desktop Recording Server and the SCOPIA Desktop 
Conference Server.
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� Gatekeeper—Displays the address of the gatekeeper to which the 
Conference Server is registered. In the special case that the 
SCOPIA Desktop Recording Server is installed separately from the 
SCOPIA Desktop Server and has its own Conference Server, the 
Conference Server must be registered to the same gatekeeper as the 
SCOPIA Desktop Server. 

� NIC Address—Displays the NIC address used by the 
SCOPIA Desktop Recording Server to communicate with the 
SCOPIA MCU.

� Recordings Folder—Displays the location of the folder on the 
SCOPIA Desktop Recording Server used for storing recordings.

� Remaining Disk Space—Shows how much space is remaining on the 
disk on which recordings are stored. 
If the remaining disk space is less than the disk space allocated 
for recordings, a warning icon is displayed. Click the icon for 
details.

� Disk Usage—Shows the amount of disk space used by all recordings. 
The maximum value is configured during installation.
To change the maximum disk space, run the installer on the 
SCOPIA Desktop Recording Server in the modification mode.

� Recordings in progress—Shows the number of recordings being 
recorded at the present moment. The maximum value appears as 
specified in the recording license installed for this SCOPIA Desktop. 

� Completed recordings—Shows the total number of completed 
recordings available for watching.

� Reconstructed recordings—Shows the number of reconstructed 
recordings.
SCOPIA Desktop saves actual recordings and recording 
attributes in different folders. If a user restores only a recording 
without restoring its attributes, the recording appears as 
reconstructed. In this case you need to manually define 
recording attributes, such as the name and the owner PIN, to 
finalize reconstruction of a recording. Only after the 
reconstruction is completed the recording appears on Watch 
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Recording page of the SCOPIA Desktop portal. If recording 
attributes are not reconstructed, the yellow attention icon is 
displayed. Click the icon for more information.

� Evaluation license—Displays information about an evaluation 
license if it is used.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Status in the sidebar.
2 Click the Recording Status tab.
3 Click the link showing the IP address of the recording server to 

display the Recording Connection Settings page.
The indicator next to each link shows whether or not the 
connection to the target server or registration with the 
Gatekeeper is successful. When the indicator is red, a tooltip 
containing error details is available. Click the red indicator to 
view further error information. 

ABOUT CONFIGURING 
THE 
SCOPIA DESKTOP 
RECORDING SERVER 
CONNECTION

This section describes how to configure SCOPIA Desktop Recording Server 
settings. Recording can be managed either by a single SCOPIA Desktop Server 
or by multiple SCOPIA Desktop Servers. 
If a single SCOPIA Desktop Server is set to manage recording, only participants 
connected through that SCOPIA Desktop Server can start or stop recording. In 
this case, you can configure other SCOPIA Desktop Servers in the deployment 
to display the list of recordings from the SCOPIA Desktop Server configured to 
manage recording.
If you configure multiple SCOPIA Desktop Servers to manage recording, the 
servers manage recording independently causing each SCOPIA Desktop portal 
to display its own list of recordings.
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To designate a single SCOPIA Desktop Server to manage recording, enable 
recording on this SCOPIA Desktop Server. In this case you must disable 
recording on other SCOPIA Desktop Server in the same deployment, and enable 
them to allow playback of recordings from an alternate SCOPIA Desktop Server 
in order to display a list of recordings in the portal.
To enable multiple SCOPIA Desktop Server for managing recording, enable 
recording on each SCOPIA Desktop Server in this deployment.

CONFIGURING THIS 
SCOPIA DESKTOP 
SERVER TO MANAGE 
RECORDING

The public address you define during this procedure performs a similar role to 
the public address defined for the SCOPIA Desktop Server. If the 
SCOPIA Desktop Recording Server resides behind a NAT, the clients might not 
resolve the SCOPIA Desktop Recording Server IP address. In this case the 
clients use the public address to connect to the SCOPIA Desktop Recording 
Server.
You can configure recording settings as well as manage recordings if you select 
this server to manage recording.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Recordings in the sidebar.
2 Click the Connection tab.
3 From the list, choose Enable recording.
4 Enter the IP address of the Recording Server.
5 In the Public Address field, enter a FQDN.

We recommend that you use a FQDN that clients can resolve. 
6 Enter the TCP port. 

This port is used by clients to access the recording in case a 
UDP connection fails.
You must configure the TCP port on the Darwin Streaming 
Server and open this port on the firewall.
For more information about configuring a UDP connection, 
refer to the “Configuring Streaming or Playback using the UDP 
connection” section of the SCOPIA Solution Deployment 
Guide.
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7 From the SCOPIA Desktop Network Interface list, choose the IP 
address. 
The SCOPIA Desktop Server uses this IP address for 
communications with Darwin Streaming Server and TCP 
Proxy.

8 Click OK or Apply.
The indicator next to the Address field shows whether not 
registration to the Darwin Streaming Server is successful. When 
the indicator is red, a tooltip containing error details is 
displayed. 

Related Topics

� SCOPIA Desktop Deployment Guide 

CONFIGURING AN 
ALTERNATE 
SCOPIA DESKTOP 
SERVER TO MANAGE 
RECORDING

If you select an alternate server to manage recording, you can configure neither 
recording settings nor manage recordings.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Recordings in the sidebar.
2 Click the Connection tab.
3 From the list, choose Enable recording.
4 In the Server URL field, enter the URL of the alternate 

SCOPIA Desktop Server.
5 Click OK or Apply.

CONFIGURING 
RECORDING 
PARAMETERS

During the configuration described in this section you define the recording 
policy by enabling the recording option for SCOPIA Desktop users and by 
specifying the type of meetings the users can record.
If you disable recording for users, you do not need to choose a meeting type.
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If iVIEW Suite is configured to moderate SCOPIA Desktop Server meetings, 
both iVIEW Suite and SCOPIA Desktop control recording. If the recording 
policy is differently configured on iVIEW Suite and SCOPIA Desktop, the more 
restrictive settings overrule the less restrictive settings, creating a unified 
recording policy. For example, if the recording policy of SCOPIA Desktop is 
configured to allow recording of any meeting, while the policy of iVIEW Suite 
is set to enable recording only for certain virtual rooms, recording of meetings in 
the specified virtual rooms will be allowed.
You also define the following parameters during this configuration:

� Video size and Recording bit rate—These parameters are used to 
control the quality of recordings.
Setting the recording bit rate to a value lower than 256 Kbps can 
affect the quality and framerate of the H.239 Data in the live 
connection and streaming modes. We recommend that you set 
the recording bit rate to 384 Kbps.

� Maximum Recording Duration—The value set for this parameter 
controls maximum allowed duration for any recording.

� Send tone periodically during recording—This parameter defines the 
frequency of the tone played during a recording which serves to 
remind users that their meeting is being recorded.

You can use the iVIEW Suite to automatically record either a virtual room or a 
scheduled meeting when the meeting begins. In this case SCOPIA Desktop 
records the meeting unless one of the following problems interferes with 
recording:

� There are not enough available recording ports on the 
SCOPIA Desktop at the time when the meeting is scheduled

� There is not enough disk space the disk on which recordings are 
stored

� The maximum number of simultaneous recordings is reached
If the deployment in use comprises multiple SCOPIA Desktop Servers, 
automatic recording is performed on all SCOPIA Desktop Servers and several 
identical recordings are created. In this case we recommend that you allow one 
of the SCOPIA Desktop Servers to perform automatic recording, while 
disabling the automatic recording feature on the rest of the SCOPIA Desktop 
Servers in the deployment. The procedure in this section describes how to 
disable the automatic recording feature on a SCOPIA Desktop Server.
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Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Recording in the sidebar.
2 Click the Settings tab.
3 From the Video Size list, choose an option.
4 From the Maximum Bit Rate list, choose a value.
5 In the Maximum Recording Duration field, enter a value.
6 From the Send tone periodically during recording list, choose an option.
7 Select the Allow meeting participants to record the following type of 

meetings check box to enable recording for SCOPIA Desktop users.
8 If you enabled recording for users, choose a meeting type:

� Any meeting
� Only Moderated Meetings—Users are allowed to 

record only meetings for which a moderator PIN is 
configured.

9 To disable automatic recording feature, clear the Allow virtual rooms 
and scheduled meetings to be recorded automatically check box.

10 Click OK.

Related Topics

� Modifying the Disk Space and Storage Location for Recordings on 
page 35

MODIFYING THE DISK 
SPACE AND STORAGE 
LOCATION FOR 
RECORDINGS

By default SCOPIA Desktop stores recordings at a location defined during 
SCOPIA Desktop Server installation, however, you can modify this location if 
required. 
During this procedure all recording services are stopped. After the new location 
is defined, all new recordings are stored at it. You must manually transfer the 
existing recordings into the new location. The recordings that are left in the 
previous location do not appear on the Watch Recording page of the SCOPIA 
Desktop portal.
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 ) Procedure

1 Click Start > Settings > Control Panel.
2 Double-click Add or Remove Programs.
3 From the list of programs, choose SCOPIA Desktop, and then 

Change.
The Setup Wizard opens.

4 In the Welcome screen click Next.
5 In the Program Maintenance screen, choose Modify, and click Next.
6 In the Custom Setup screen, click Next.
7 In the SCOPIA Desktop Serial Key screen, click Next.
8 In the SCOPIA Desktop Network Configuration screen, click Next.
9 In the SCOPIA Desktop Hostname Configuration screen, click Next.
10 In the SCOPIA Desktop Recording Configuration screen, modify the 

storage location:
a Click Change.
b Navigate to a new location.
c Click OK.

11 To modify the maximum amount of disk space, enter new value in the 
field.

12 Click Next.
13 Click Install.

UPDATING THE 
SCOPIA DESKTOP 
SERVER IP 
ADDRESS ON THE 
STREAMING OR 
RECORDING 
SERVERS

When the Streaming or Recording components of SCOPIA Desktop are 
installed on their own server, separately from the SCOPIA Desktop Server, they 
are configured with the IP address of the SCOPIA Desktop Server which is 
allowed to connect to them. If the IP address of the SCOPIA Desktop Server 
changes, you need to update it on the Streaming and Recording Servers.
When the SCOPIA Desktop Server IP address is not updated on the Streaming 
or Recording Server, it is indicated on the Status tab of the SCOPIA Desktop 
Administration web user interface. If you click the Streaming Server or 
Recording Server indicator, this error is displayed: “5003 Access denied error 
from proxy”.
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Before You Begin

Access the Streaming Server or Recording Server.

 ) Procedure

1 From the Start menu, choose Programs > SCOPIA Desktop > 
TCP Proxy Configuration.

2 Run the listServers command to display the address of the 
SCOPIA Desktop Server which is allowed to access the Streaming or 
Recording Server.

3 If the SCOPIA Desktop Server address is incorrect, run the 
removeServer command to remove it.

4 Run the addServer command to add the correct address.
5 Follow on-screen directions to complete the procedure.

HOW TO MANAGE 
RECORDINGS

� Viewing Recording List on page 37
� Editing Recording Attributes on page 39
� Setting Categories for Multiple Recordings on page 40
� Deleting Recordings on page 40
� Stopping Recordings in Progress on page 41
� Recording Meetings on page 42

VIEWING RECORDING 
LIST

You can review the list of recordings made on this SCOPIA Desktop using the 
Recordings tab. The following information is displayed:

� Meeting ID
� Name
� Start Time
� Duration

Note For meetings that are currently being recorded, the “In progress” 
indication is displayed.

� PIN-protected indicator
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You can also access for the following additional information for a specific 
recording: 

� Description
� Categories—Keywords associated with recordings.
� Recording URL

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Recordings in the sidebar.
2 Click the Recordings tab.

The Recordings tab is displayed showing a list of recordings. 
By default all recordings are displayed.

3 To filter recordings, select a category from the Show list.
4 To sort recordings, click one of the columns:

� Meeting ID
� Name
� Start Time
� Duration

5 To search for a specific recording by an attribute:
� Meeting ID—Click the Meeting ID column, enter the 

meeting ID in the Search field, and then click the 
Search button.

� Meeting Name—Click any column except the 
Meeting ID column, enter the meeting name in the 
Search field, and then click the Search button.

6 To display additional information for a specific recording,   
click the Information icon. The Meeting Information window 
opens.
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EDITING RECORDING 
ATTRIBUTES

You can assign an owner and an access PIN for recording protection. The access 
PIN is optional and is used for watching a recording. In the list of recorded 
meetings protected by an access PIN are marked by a key icon. The owner PIN 
is used only for editing a recording.
You can define what part of a recorded meeting is played by setting offsets. In 
this case while the playback of a recording changes, the duration of the 
recording itself is not shortened. For example, to omit the first five minutes of a 
recording, set the Start offset to 5 minutes.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Recording in the sidebar.
2 Click the Recordings tab.
3 Locate the required recording in the list.
4 Click the Edit icon.

The Edit Recording window is displayed.
5 To modify the recording name and description, enter new text in 

relevant fields.
6 To set offsets:

� Pull sliders
Or

� Edit values in the fields.
7 To modify categories for the recording, select a category in the relevant 

pane and click the Transfer button.
8 To set the owner PIN for the recording, enter the owner PIN.
9 To set the access PIN, enter the access PIN.
10 Click OK.
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SETTING CATEGORIES 
FOR MULTIPLE 
RECORDINGS

You can set categories for multiple recordings at one time.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Recording in the sidebar.
2 Click the Recordings tab.
3 In the recording list, click check boxes to select recordings.
4 Click Categorize.

The Categorize Recordings window opens.
5 To assign a category, which is not currently assigned to selected 

recordings:
a In the left pane, click the check box for this category.
b Click Assign.

6 To remove a category, which is currently assigned to selected 
recordings:
a  In the right pane, click the check box for this category.
b Click Remove.

DELETING 
RECORDINGS

You can permanently remove a recording from SCOPIA Desktop by deleting it 
from the recording list.
When you delete a recording which is in progress, the meeting participants are 
notified that the recording is stopped. The meeting moderator receives a 
notification that the recording is deleted by the administrator.
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Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Recordings in the sidebar.
2 Click the Recordings tab.
3 In the recording list, click the check box for recordings you wish to 

delete.
4 Click Delete.
5 Click Yes in the confirmation message.

STOPPING 
RECORDINGS IN 
PROGRESS

You can stop any recording that is in progress. When you stop a recording in 
progress, meeting participants are notified that the recording is stopped. The 
meeting moderator receives a notification that the recording is stopped by the 
administrator.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Recording in the sidebar.
2 Click the Recordings tab.
3 In the recording list, click the check box for recordings you want to 

stop.
4 Click Stop.
5 Click Yes in the confirmation message.
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RECORDING MEETINGS You can record meetings using the SCOPIA Desktop Administration web user 
interface.

Before You Begin

� Verify that you have the ID of a meeting you want to record.
� Navigate to the SCOPIA Desktop Administration web user 

interface.

 ) Procedure

1 Click Recording in the sidebar.
2 Click the Recordings tab.
3 In the Start recording meeting ID field, enter ID.
4 Click Record.

The Start Recording window is displayed.
5 Enter recording name and description.
6 Assign categories as necessary.
7 To set the owner PIN for the recording:

a Choose either the Use the moderator PIN as the 
Owner PIN or Specify an Owner PIN option.

b Enter the owner PIN.
c Enter the owner PIN in the Confirm field.

8 To set the meeting PIN:
a Choose the Use the meeting PIN as the Access PIN 

or Specify an Owner PIN option.
b Enter the access PIN.
c Enter the access PIN in the Confirm field.

9 Click Start Recording.
The meeting appears in the list, and its duration is indicated as 
“In Progress”.

MANAGING 
CATEGORIES

Apart from standard attributes like an ID, name, and duration, SCOPIA Desktop 
provides a category—a special attribute that can help organizing and searching 
recordings. Both users and administrators can assign categories to recordings. 



Configuring SCOPIA Desktop for Administrators  43

How to Restore Recordings

Administrators manage categories by modifying a list of existing categories, 
while users can only select categories from this list to associated them with 
recordings.
If you rename an existing category, SCOPIA Desktop automatically updates 
attributes for all recordings belonging to the modified category. Deleting a 
category does not cause SCOPIA Desktop to delete recordings belonging to the 
deleted category.

Before You Begin

� Navigate to the SCOPIA Desktop Administration web user 
interface.

 ) Procedure

1 Click Recording in the sidebar.
2 Click the Categories tab.
3 To create a new category:

a In the Create a new category field, enter the name.
b Click Create.

The new category appears in the list.
4 To edit an existing category:

a Click the Edit icon.
b Enter the new name for the category.
c Click OK.

5 To delete an existing category:
a Click the Delete icon.
b Click Yes.

HOW TO RESTORE 
RECORDINGS

SCOPIA Desktop saves actual recordings and recording attributes in different 
folders. In order to restore a recording you need to restore both folders.

� Backing up Recordings on page 44
� Restoring Recordings on page 44
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BACKING UP 
RECORDINGS

Perform the backup procedure described in this section on the SCOPIA Desktop 
Recording Server. During the backup procedure, you copy the xml file that 
contains the database of categories configured, the recordings folder containing 
recording attributes, and the folder containing actual recordings to a location 
outside the installation directory.

 ) Procedure

1 Navigate to the following directory: 
<installdir>\CSAgent\data.

2 Copy recorder_categories.xml file into a location outside the 
installation directory.

3 Copy the recordings folder into a location outside the installation 
directory. 

4 Navigate to the folder where recordings are stored.
By default, the recordings are stored in the 
<installdir>\Movies\recordings, if not configured otherwise. 

5 To check the location where recordings are stored:
a Access the SCOPIA Desktop Server Administration 

web interface.
b Click Status in the sidebar.
c Click the Recording Status tab. 

The Recordings Folder information is displayed on the tab.
6 Copy that folder into a location outside the installation 

directory.

RESTORING 
RECORDINGS

 ) Procedure

1 Stop the service "SCOPIA Desktop - Apache Tomcat".
2 Stop the service "SCOPIA Desktop- TCP Proxy". 
3 Navigate to the following directory: <installdir>\csagent\data.
4 Replace recorder_categories.xml file with the backup file.
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5 Replace the recordings folder with the backup folder.
Replacing the recordings folder with the backup folder erases 
any categories that are currently defined in SCOPIA Desktop.

6 Navigate to the folder in which recordings are stored.
 By default, the recordings are stored in the 
<installdir>\Movies\recordings, if not configured otherwise. 

7 To check the location where recordings are stored:
a Access the SCOPIA Desktop Server Administration 

web interface.
b Click Status in the sidebar.
c Click the Recording Status tab. 

The Recordings Folder information is displayed on the tab.
8 Replace that folder with the backup folder.
9 Start the service "SCOPIA Desktop - Apache Tomcat".
10 Start the service "SCOPIA Desktop - TCP Proxy".

HOW TO BRAND 
SCOPIA DESKTOP 
USER INTERFACE

SCOPIA Desktop Server is released with a set of default images appearing in 
the SCOPIA Desktop user interface. However, you can change images and 
strings displaying irrelevant branding information using the SCOPIA Desktop 
Branding application.

� Replacing Images on page 45
� Modifying Strings on page 47
� Saving or Restoring Branding-related Changes on page 48
� Restoring Default Images and Strings on page 48

REPLACING IMAGES You can replace images appearing in the SCOPIA Desktop user interface by 
using the Branding application on SCOPIA Desktop Server. Replacement takes 
affect immediately, therefore we recommend that you should not replace images 
on a server that is currently in service. Replacement does not affect the proper 
function of the SCOPIA Desktop user interface.
Most web browsers store local copies of images to accelerate future views of the 
same image. This practice is called caching. Any browser that has previously 
loaded an image that you replace might display its local copy of the old image 



46 SCOPIA Desktop Server Administrator Guide

How to Brand SCOPIA Desktop User Interface

rather than your replacement image. If an image in the SCOPIA Desktop user 
interface does not appear to be the same as the one displayed as the currently 
installed image, then you must clear your browser's cache. 
SCOPIA Desktop Server is released with a set of default images that you can 
restore at any time.

 ) Procedure

1 Click Start.
2 Choose Programs > SCOPIA Desktop > Branding Application.

The branding application starts.
3 Click the Images tab.

The images that can be replaced are displayed together with the 
recommended size and a brief description of each image.
If an image has a transparent background, it appears with a gray 
and white “checkerboard” background in the preview fields.

4 From the list, choose the image you want to replace.
A brief description of the image is displayed along with the 
recommended image size. The Default image area shows the 
image that was originally distributed with the product. The 
Currently installed image shows the image that appears in the 
user interface.

5 Click Select File, and then choose the replacement image.
A preview of the image is displayed.
If you use an image that the application indicates as not properly 
sized, a warning appears below the image description. Using an 
image that does not match the original image size might result 
in incorrect image display. 

6 If you use an image that is not properly sized, verify that the image is 
displayed correctly:
a Verify that the SCOPIA Desktop Server is running.
b Review the SCOPIA Desktop user interface after 

replacement to verify that the image appears correctly.
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7 Click Install Image to use the replacement image.
This image is replaced.
If an old image still appears, see your browser's documentation 
for information about removing temporary internet files.

8 To restore a default image, click Restore Original Image.
9 Repeat step 4 through step 7 for other images.

MODIFYING STRINGS You can modify some strings appearing in the SCOPIA Desktop user interface. 
New string values you set using the Branding application appear in the user 
interface only after SCOPIA Desktop Server starts and reads these values. 
Therefore, you can see modified strings only after the changes are applied and 
after the server is restarted if it was running when you made the changes.

 ) Procedure

1 Click Start.
2 Choose Programs > SCOPIA Desktop > Branding Application.
3 Click the Strings tab.

The strings that can be replaced are displayed along with the 
their values:
� The Rebranded Value column displays values that are 

currently saved. When the SCOPIA Desktop Server is 
restarted, these are the values that appear in the user 
interface. 

� The Default Value column displays values that are the 
original strings that were distributed with 
SCOPIA Desktop.

4 Click the relevant cell in the New Value column and type in the new 
string you want to use.
Or
Double-click a value in the Rebranded Value column or the 
Default column to copy it into the New Value column.

5 Repeat step 4 for other strings if necessary.
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6 Click Apply.
The new values are saved. The modified values appear in the 
Rebranded Value column.

7 Restart the “SCOPIA Desktop - Apache Tomcat” service for 
the changes to take affect.

8 To restore default strings:
a Click Restore All Default Strings.
b Click Apply.
c Restart the “SCOPIA Desktop - Apache Tomcat” 

service for the changes to take affect.

SAVING OR RESTORING 
BRANDING-RELATED 
CHANGES

You can save modified images and strings by exporting them to a file. You can 
later use this file to import values from it, thus restoring them.

 ) Procedure

1 Click Start.
2 Choose Programs > SCOPIA Desktop > Branding Application.
3 To save modified images and strings:

a From the File menu, choose Export.
b Specify the location in which you want to save the file.
c Click Save.

4 To restore the modified images and strings from the file:
a From the File menu, choose Import.
b Navigate to the export file.
c Click Import.

5 Restart the “SCOPIA Desktop - Apache Tomcat” service for the 
changes to take affect.

RESTORING DEFAULT 
IMAGES AND STRINGS

SCOPIA Desktop Server is released with a set of default images and string 
values. You can restore both default images and default string values in one go. 
Restoring default images and strings overwrites currently used images and 
string values with default ones.
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 ) Procedure

1 Click Start.
2 Choose Programs > SCOPIA Desktop > Branding Application.
3 From the File menu, choose Restore all.
4 Restart the “SCOPIA Desktop - Apache Tomcat” service for 

the changes to take affect.

VIEWING THE 
SCOPIA DESKTOP 
ONLINE HELP

 ) Procedure

1 Access the SCOPIA Desktop Server Administration web 
interface.

2 Click the Help icon in the top right corner of the Administration web 
user interface.

Related Topics

� Accessing the Administration Interface on page 10
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